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Documenting and Presenting your Work Guide 
By Joanna Kinnersly-Taylor – Textile Artist and Designer 

Documenting Your Work 

It is very important to document all areas of your practice – both in written and visual form. If 

you develop a simple system of recording information from the outset, it makes life much 

easier. You might be asked to supply an image at short notice or include specific back-up 

material as part of an application, and having this at least partly prepared can save an 

enormous amount of time. Every situation will require something slightly different, so written 

material can be adapted to suit the particular circumstance and visuals can be saved in a 

variety of formats. With time, you build up a range of information that enables you to respond 

effectively to any enquiry or request. 

Images  

A digital image, slide or photograph will often be a potential client's first point of contact with 

your work and it cannot be overstated how important it is to have images of the highest 

quality and this means paying for the services of a professional photographer. Although this 

can be costly, it will be a worthwhile investment, as good images will take you a long way. 

Get a personal recommendation if possible, by asking other makers in your field who they 

use; alternatively look at the advertisements in magazines like a-n. Before employing a 

photographer for the first time, ask to see examples of their work to get an idea of their style. 

Make sure you are both clear about the kind of images you want to achieve in order to 

project your work to its best advantage. For site-specific work, it will be important to have 

views of the whole piece in context as well as some details; with products; a different 

approach will be needed.  Before the shoot, take some time to plan the compositions you 

want - it's much harder than you think! Look at magazines and other maker's images to get 

an idea of what works best. Think about any props you might use to give a sense of scale or 

an identity / lifestyle feel to the product. 

 

However, keep the compositions simple, striking and dynamic and bear in mind the various 

ways the image may be used. For example, in a show catalogue, where a large number of 

images are shown within a limited amount of space, the picture will be small so your product 

needs to be able to stand out and be legible even at passport photo size. If you are targeting 

magazines with your images, it can be useful to have some compositions where the object is 

photographed against a plain background, preferably white, so that the picture desk can 

easily create a 'cut out'.  It is worth taking photographs of possible compositions and set-ups 

yourself beforehand - a digital camera is useful here - so that you can show the 

photographer what you have in mind. This will save you money too, as the quicker the job, 

the cheaper it will be!  
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Transparencies (Slides) and Scanning to Create Digital Images 

Despite the digital revolution, most artists and designers still want images as transparencies  

(also known as film positives) as their originating format. These are mostly as 35mm slides, 

although other sizes, grouped into ‘medium format’ or ‘large format’ categories, may also be 

desirable, depending on the type of work being photographed and final output. The larger 

the size of the transparency, the more expensive it becomes.  The most commonly used 

medium format size is 6cm x 7cm; this is a publishing industry standard because the 

proportions are suited to a variety of printed media. Other sizes in this category are 6cm x 

4.5cm and 6cm x 6cm. Medium format is also very good for reproduction, giving the best 

quality possible for a range of reproducible formats.  The most widely used large format size 

is 5” x 4”, which is used for architectural photography and images where there is a lot of 

detail. This size is used as standard in Germany and other European countries. 

 

Although there has been a great decline in the use of slides, occasionally I still find I may be 

asked for these when putting together an application. Until their use has completely died out, 

I would recommend getting your film developed both as mounted slides and scanned images 

onto CD. At the lab you should ask for images to be scanned to disc and saved in three 

quality categories: high, medium and low; they will probably be saved as JPEG files. Ask the 

lab at what resolution they scan images.  Normally 35mm or medium format transparencies 

are scanned at 300PPI (pixels per inch), with large format at 200PPI. Note: as discussed 

later, there is often confusion over the use of the terms PPI and DPI (dots per inch). Photo 

labs will often talk about scanning at DPI, although strictly speaking, scanning resolution is 

measured as PPI, although some scanning software still refer to DPI. DPI only relates to the 

quality of the output – the printed image. Magazines will ask for images that have a 

resolution of 300DPI, when what they really mean is PPI. 300DPI is the publishing industry 

standard (see below under 'Pixel Dimensions and Resolution' for more information on DPI 

and PPI).  

 

You might also want to ask the size of the high-resolution files. For example, a 40MB file 

would easily be big enough to print out at A2 size, or 20-25MB for an A4 print. Scanning is 

expensive, but the huge advantage is that you end up with a CD from which you can 

generate an unlimited supply of images in a variety of formats, making it very cost-effective 

in the long term. Slides that you decide to put onto a CD at a later date will be much more 

expensive to scan than if done at the time of developing; remember that only original slides 

should be scanned. If you have a scanner with a ‘transparency hood’, then you scan slides 

yourself, but in my experience the quality is poor compared with professionally scanned 

slides. If you do scan slides yourself, you will need to enlarge them at this stage, otherwise 

you will end up with a tiny image on the screen and it won't be possible to increase its size 

without losing all the quality.  See below for more information on this. 

 

Note: Readers may find it useful to refer to the excellent and detailed coverage of digital 

media at www.en.wikipedia.org, and its linked sites – just type in ‘digital images’ and 

search.  I also find the range of 'Quickstart' books published by the Peachpit Press (for 

Photoshop, PowerPoint etc.), very user-friendly. 
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Saving Files in a Variety of Formats and Sizes 

Once you have your CD from the lab, make a copy of it and put the original away in a safe 

place. Using the copy CD to work from, you should now open each image file in Photoshop, 

and re-save as TIFF files onto another CD. The reason for this is that due to the 

compression process used (known as ‘lossy’ compression – selectively discarding data to 

reduce file size), JPEG files suffer degradation when repeatedly opened, edited and re-

saved, so it is best to keep your original JPEG disc intact and make any further changes 

required to the newly-saved TIFF files. 

Some File Types and their Uses 

JPEG (Joint Photographic Experts Group) 

The most common type of picture file, a JPEG uses lossy compression and is suitable for 

continuous tone images such as photographs. CMYK, RGB and grayscale images can all be 

saved as JPEG files, although some applications may be unable to read a CMYK file saved 

as a JPEG. A low quality JPEG is ideal for e-mailing (especially if you don't have 

broadband), although not for printing out from. A JPEG image with a low resolution of 72PPI 

is suitable for use on the web. 

 

To re-save a JPEG file with different settings, or a different file type as a JPEG file: 

• Open the file in Photoshop 

• File > Save As > choose location for new file and re-name if desired 

• Format > select JPEG 

• Save > Image Options > select a number between 0 and 12 on the scale to 
determine image quality (remember the higher the quality, the larger the file; the Size 
display shows the projected file size and estimated download time with selected 
modem speed 

• Format Options > Baseline (“Standard”) is widely recognised, whereas the other 
options may not be supported by some browsers 

GIF (Graphics Interchange Format) 

A standard format for compressing images with sharp detail, and flat or large areas of single 

colour, such as logos or illustrations with type. The compression format used for GIF files is 

known as ‘lossless’, so crispness of image is retained. Suitable for use on the web. 

TIFF (Tagged Image File Format) 

A highly flexible, archive-quality, bitmap (grids of dots known as pixels) image format, with a 

maximum file size of 4GB. Photoshop CS supports large documents saved as TIFF files, but 

older versions and other applications won’t open files larger than 2GB. Available with both 

lossy and lossless compression. A TIFF file is still regarded as standard in the printing 

industry and if you need to supply images to magazines or for reproduction in books, this is 

the format you would use.  

  

Note: When you save an image as a TIFF file, remember to check the correct box in the 

‘Byte Order’ option; this selects the platform on which the file can be read. If you are unsure 
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as to which programme the file may be opened in, it’s best to save two versions, one as IBM 

PC and one as Macintosh. Photoshop and most recent applications are able to read either. 

File Size 

File size, measured in kilobytes (KB), megabytes (MB) or gigabytes (GB), partly relates to 

the pixel dimensions of the image. The greater the number of pixels, the more detail that can 

be produced at a given printed size and the larger the file size; larger files will be slower to 

edit and print.  Files that have the same pixel dimensions may vary in size depending on 

their format – whether JPEG, GIF etc. and would also be affected by colour bit-depth and the 

number of layers and channels.  

 

1 GB = 1,000 MB = 1,000,000 KB 

Resolution and Pixel Dimensions  

Resolution is defined by 'PPI' (pixels per inch).  However, 'DPI' (dots per inch) is also 

sometimes used. As mentioned earlier, DPI refers to the resolution of the output, i.e. the 

quality of the printed image and so it is not accurate to refer to the resolution of an image in 

terms of DPI. PPI is used to describe the scanning resolution. Older image editing and 

scanning software may still describe resolution in terms of DPI, which is confusing, although 

most up-to-date programmes like Photoshop now refer to PPI. An image scanned at a low 

PPI cannot be improved by increasing the resolution in Photoshop later, so I would 

recommend always scanning at a default of 300PPI.  Remember also to scale up your image 

at the scanning stage (as with slides); for example if you think you will want to print, say, a 6" 

x 4" photo out at twice the size later on, it would need to be scanned at 200%. The pixel 

dimensions are measured by the number of pixels along the height and width of a bitmap 

image and determine the level of detail contained in that image; the greater the number of 

pixels the higher the level of detail and smoother the colour transitions; the file size is also 

larger. For example, a 9" x 6" photo scanned at 300PPI at 100% will have pixel dimensions 

of 2700 (9 x 300) x 1800 (6 x 300). 

 

Resolution can be altered in Photoshop, and how you do this affects the result. To 

summarise, if you increase an image's resolution with the 'Resample Image' box selected, 

pixels will be added, the file size will increase but the quality will be reduced.  If you 

decrease the resolution, information will be discarded, resulting in a smaller file, again of 

lesser quality. Any blurring of the image may only be discernable when printed, so a 

reduction in resolution is suitable for adapting images for the web.  Adjusting resolution 

without selecting the 'Resample Image' box will result in the document size increasing or 

decreasing proportionally; the pixel dimensions remain unaffected.  

 

Reducing the PPI of an image from 300PPI to 72PPI for the web: 

• Open your file in Photoshop 

• Image > Image Size > select the 'Resample Image' checkbox  (select 'Bicubic' – this 

is the best interpolation method as it causes the least degradation 

• Resolution > type in '72' (notice how the document size remains the same, but the 

pixel dimensions decrease proportionally) 
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Photographs 

These would be printed out from your high-resolution files. The lab that scanned your slides 

will be able to produce machine prints with good colour accuracy to your original; these will 

be much cheaper than those done by hand. Of course, you can also print out images 

yourself on a variety of different papers at the required size, but be wary of overly enlarging 

images – it's best to scan at a larger size that you can then scale down from.  

Burning CDs 

When you burn a CD to send out, ensure that the recipient is able to read it. The newest 

processors automatically burn discs so that both Mac and PC users can read them. 

However, if you are using software such as ‘Toast’ on older computers, make sure you 

check the ‘hybrid’ box.  

Labelling Visuals 

Slides and photographs should be clearly labelled, usually with the following information: 

your name, title or description of work, medium, size and date. For slides, spread this over 

two labels, one at the top, one at the bottom; a sticky red dot should also be used to denote 

the top. I favour using Avery slide labels and typing the text rather than handwriting, as it is 

clearer and looks more professional. 'Word' software has templates for all Avery labels, so 

it's very easy to position text correctly and of course you can save it.  

 

Sometimes applications set out how slides should be labelled and this may include specific 

positioning of information and numbering. You should also have a label on the reverse of the 

slide with the photo credit and telephone number of the photographer. For prints, all 

information can be typed on an address-size label stuck to the reverse. A CD should of 

course be labelled with your name and contact details; again Avery make labels for this 

purpose. However, you can now buy CDs with a printable surface and newer printers have a 

special facility for this. 

Keeping Track of Visual Material 

I find it very useful to keep a note of exactly what I send out to everyone and the date it was 

sent; if sending slides I also note whether it was an original or copy. I also normally save a 

copy of any PowerPoint presentations on a specific disc and this can be useful when 

compiling future mail-outs or applications. Overall, it serves as a useful reminder as to what’s 

out there! 

Publicity & Promotion 

Press Packs 

A press pack is essential if you have a stand at a trade show or retail event such as ‘Origins’. 

It is also something you can compile if you are doing a mail-out to the press to promote new 

work. Journalists get bombarded with press releases every day and many will go straight 

into the bin, therefore it’s important that the information provided is well written and visuals 

eye-catching. Most journalists will be delighted to be given a press pack, as it makes their 

job much easier.  It can consist of some or all of the following, as appropriate, placed inside, 

e.g. an A4 plastic wallet: 
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• a press release: this should be typed on letterhead, double-spaced and with wide 

margins so that there is room for the journalist to make notes.  It should be clear, 

concise and contain all the relevant information in a logical way, namely - what, 

when, where, why, followed by a brief description of your work, the making process, 

your clientele etc. - all summed up in 3 or 4 paragraphs.  Your contact details should 

be repeated at the bottom and the word 'ends' finishing the press release. Make sure 

this document is at the front of the wallet. 

• CD of your work: as one will not see the contents of the press pack again, CDs really 

are an improvement on slides. Save files in three versions: TIFF and JPEG formats 

(high and low quality), so that the journalist has every option covered. Make sure the 

files are named and numbered clearly, with titles that are descriptive and easily 

distinguished by the viewer. Include a corresponding image list that includes all 

relevant information about each work; for even greater clarity, thumbnails of each 

image could also be added, but keep it all on one A4 sheet. Remember to select your 

strongest images – three or four really striking pictures will go further than a dozen 

mediocre ones. 

• a short (one page) CV:  see below. 

• postcard(s): see below. Put this at the front, with the press release, so that the 

subject matter can be seen at a glance. 

• a business card 

Postcards 

Postcards are a relatively inexpensive way of creating high quality promotional material that 

has a multitude of uses. There are many companies specialising in postcard printing for 

artists and designers and some advertise in 'Crafts' or 'AN' magazine.  Send off for sample 

packs to assess the quality. The most common size is 6" x 4" and the reverse should include 

your name and contact details, a description of the image or type of work you do, together 

with a photo credit. If you exhibit your work regularly, you may wish to consider having a 

proportion of the cards printed without your address and phone number so that the gallery or 

shop can have your cards for sale.  For example, I use Abacus Colour Printers in Cumbria 

and on a run of 1,000 cards I omit selected text after 750 cards, leaving me 250 for 

exhibiting purposes.  

Press Cuttings 

A press cuttings file is a useful document to have, not only for your own records, but to 

demonstrate to others that your work or products have received publicity, which helps 

increase their confidence in you. If you have a particularly good article or image in a 

magazine, it can be worth ordering a 'showcard' (currently around £17). This is the relevant 

page of the publication mounted and laminated on thick card with the magazine masthead at 

the top and a foldout stand behind; it's very useful to have on display at a show. I normally 

buy two copies of any magazine I have work featured in - one to keep and one to cut out and 

put in the press cuttings file. I also use this to scan or have colour photocopies done. 
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A4 Presentation Book / Portfolio 

An A4 presentation book (with clear plastic sleeves) is an effective way to show your work, 

whether during a show or to take to a meeting and it can be adapted to suit a variety of 

situations. For example, for the promotion of my table linen, I have a book that includes 

photographs of the products (9" x 6" mounted on A4 card), fabric samples and price lists. I 

have another book where the emphasis is on commissioned or gallery work. I also include a 

CV and statement, and a price list if relevant. 

Web Sites 

There are dozens of web sites all vying for your images and money.  Other than having your 

own, it can be useful to include your work on other sites, to ensure you reach a broad 

audience, but be selective. I have my work on three: 'AXIS' (aka Visual Associations) 

(www.axisweb.org.uk); 'design nation' (www.designnation.co.uk) and the Crafts Council's 

'Index of Selected Makers' (recently available to subscribers; www.craftscouncil.org). 

These are established and well-managed sites that suit the range of work I do; all required a 

selection process. If a gallery represents you, they may include your work on their web site 

too. 

Commissioning Agencies 

These are organisations that co-ordinate and manage a project on behalf of their client.  

They source artists and keep a database and image bank where potential clients can view 

artists' work. If you have your work represented by commissioning agencies, it is very 

important to make sure you keep your images and CV up to date. Each agency or agent will 

require information in a specified format, so always check to ascertain exactly how they want 

you to present your work.  

 

One scenario is to send a CD that includes the following: your CV and statement as Word 

documents; a PowerPoint presentation (remember to use low quality JPEGs) as well as 

each image saved as separate high quality JPEG files (enabling print outs) and a 

corresponding image list with all relevant information (also as a Word document). Make sure 

the image file sizes allow for high quality printouts measuring at least 9"x 6". 

Applications 

With any application it is important to read the guidelines through carefully first - it may  

sound obvious, but it is surprising how easy it is to miss something. Always follow 

instructions exactly, whether it be presenting images in a certain way or completing a 

question within a set number of words - sometimes not adhering to the procedure can render 

an application invalid. I always include a covering letter detailing the items I am enclosing 

and would normally include an SAE for the return of visuals. The exception to this would be if 

there was a submission fee, in which case return postage is often included in this. Most 

applications will specify the number of images required; where this is not stated, I would 

recommend not sending more than 12. As well as visual material, applications also require 

some or all of the following: a CV, a statement, an image list, a 'statement of intent' and/or 

an 'expression of interest' (for commissions - see below) and occasionally, references. In 

any application, images (in whatever format) must be clear, well presented and easy to view 

and assess. Other visual material, e.g. copies of press cuttings or exhibition catalogues can 
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sometimes be useful as back-up, but applications that include too much material that is not 

requested and not relevant, are less likely to be successful. 

 

Finally, remember to allow enough time to get your application in for the deadline. It can be 

helpful to do it in stages, so that you can edit and refine it; showing it to someone else to 

read through is also a useful process. If you are running very close to the deadline, send it 

by Special Delivery or equivalent to guarantee its safe arrival on time. 

Exhibitions 

Your choice of images should reflect the nature of the exhibition to which you are applying.  

For example, the selection process for ‘Origins’ is very specific in that applicants are 

required to send six images that will be viewed simultaneously. It is therefore important that 

these not only reflect the work you wish to show, but are coherent as a group and show a 

strong conceptual focus or visual identity. 

Commissions  

Many of the key points for applications apply here. However, there are specific aspects to 

applying for a commission, which will vary with each one. For example, you might be asked 

to write an 'expression of interest', other than just a written declaration of interest in the 

project. This could include a description of previous experience and how this proves your 

suitability for the project and would usually come within the covering letter.  Sometimes you 

are also asked to give a 'statement of intent', which is an outline of how you would approach 

the commission, e.g. subject matter, materials, scale etc. The level of detail would depend 

on how much information the client provides; sometimes there will be lots of visuals to refer 

to, together with a written background to the project. This varies greatly depending on the 

commissioning body and how organised they are and is sometimes best placed within the 

covering letter, but sometimes required to be separate. In general, a concise approach is 

best; write as clearly, simply and economically as is possible to get the information across. 

Again, choice of images would be tailored to suit the particular project, whether in terms of 

scale of work, public or domestic environment, subject matter or materials etc. Unless stated 

otherwise, I would normally present visuals within a PowerPoint presentation.  

Curriculum Vitae (CV) 

A curriculum vitae, (also known, particularly in the USA, as a résumé) is an essential part of 

any application and enables the client / funding body to see at a glance the  

background to your professional life, such as training, achievements and publicity. Whilst all 

CVs must be factual, they can be tailored to different needs; a shorter one (one page), of the 

more essential and main points might be appropriate, or one highlighting the specific areas 

most relevant to the application. A CV should always have contact details at the top, 

thereafter, sub-headings make the CV easier to read and assess. For instance, date of birth, 

training, commissions, exhibitions, awards and media coverage. 

 

Further divisions might be appropriate, for example, solo shows, group shows, or to simplify 

to the most important exhibitions only, selected group shows, or selected solo shows. It is 

important the CV is not overfilled with details that have become of minor importance 

compared to more recent achievements; keep the most relevant and prestigious. Items 
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within each category should be in chronological order, and in the modern practice, starting 

with the most recent, working back as you go down the list. 

Statement 

A statement about your work can be a useful summary of your practice. It might cover a 

description of the type of work you do, your inspirations and influences and what materials 

and processes you use. This should be concise, and be double-spaced and on letterhead.  

Sometimes it might be appropriate to include a brief version at the beginning of your CV. 

Commission Proposals 

The exact nature of the work presented at the proposal stage will depend on a number of 

factors. Normally the proposal would include some or all of the following as appropriate to 

your art form: 

• scale drawings / designs: these would vary, but as an example, a textile commission 

would need to include: elevations, plan (if 3-dimensional) and technical drawings 

showing basic structural information including materials, dimensions, how work would 

hang or be fixed etc.  

• a model (3-D work) or samples (textiles).  

• an 'in-situ' impression - usually the most important part of the proposal, as it should 

enable every member of the selection panel to effectively and easily envisage your 

concept as it will look in the proposed site. This could be done using 'Photoshop' and 

although it won't be to scale, should be as precise as possible. 

• PowerPoint presentation of all visuals – scan drawings and photographs and save as 

low quality JPEGs. A PowerPoint is useful if you have to attend an interview and 

present your ideas to a group of people, although you would, of course, also have all 

the actual work available to view.

• a written description explaining the concept; technical details (including health and 

safety issues such as flame-proofing (textiles), hardiness to weather and vandals 

(outdoor work), maintenance etc.) and likely time-scale for production.  

• Budget: it is important to build up as accurate a picture as possible of all the costs. 

The key elements in the budget would include: 

• materials; any fabrication costs out with the studio; studio costs - 

rent/rates/insurance/electricity and other consumables; transport; installation; labour - 

artist, any assistants; and finally a contingency, normally around 10%. VAT should be 

added where necessary. 

The scale of your drawings and samples would depend on what was most appropriate for 

the project as well as practicalities such as whether you will transport and present the work 

yourself, or if it has to be posted, and facilities for storage by the client. 

 

Disclaimer: Cultural Enterprise Office is not responsible for any advice or information provided by 

any external organisation referenced in this guide. 


